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Introduction

Mail Server Lite  is a software program
designed to let you use one E-mail account to give
up to five clients their own individual E-mail
address.   Mail server allows you to share either a
Domain POP E-mail account or a regular ISP E-mail account.

        Mail Server Lite  and Mail Server Pro both work in
conjunction with the network device that Mail Server Lite was
bundled with.   Neither Mail Server Lite  nor Mail Server Pro will
function unless it "Sees" that this network device is installed on the
same network.

Note!

Mail Server Pro

Mail Server Pro  is a more
powerful version of Mail Server
Lite  and allows you to share up to
20 regular ISP or domain POP
E-mail accounts.  Every E-mail
account can then  be used to give
up to 64 individual E-mail
addresses.  To obtain Mail Server
Pro please contact your Mail
Server Lite place of purchase.
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Domain POP E-mail accounts

Mail server supports Domain POP E-mail accounts.  Domain
POP E-mail accounts are special E-mail accounts that some ISPs
offer.  With this type of account, an E-mail address like
anyhing@company.com, where anything can be any text string, will
go into the same E-mail account.  For example,  john@company.com
, lisa@company.com , simone@company.com,
rachel@company.com , etc…  will all go into one mailbox in your
ISP.    Mail server can then take all the mail from that Mail account
and distribute it to it's respective recipients:

All mail sent to anything@company.com  will end up in one
mailbox at your ISP.    Mail server can then periodically dial-in to
your ISP, retrieve all the mail and sort it into mailboxes that you
define based on the user name.  Each client can then use their E-mail
applications like Internet Mail, Eudora, Outlook Express, etc and
login to Mail server to retrieve their mail just as if they were logging
into their ISP.

simone@company.com andrea@company.com

1 ISP Mailbox

LAN

Andrea's
Computer

Simone's
Computer

Mail Server on
Any Windows

95/NT
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Regular ISP E-mail accounts?
Mail server also supports regular ISP E-mail accounts which

are just those E-mail accounts that come with regular dial-up ISP
accounts.    Mail server lets you share these accounts by letting you
take an E-mail account like mail@company.com and then assigning
individual E-mail addresses to share that  account.

For example:

           All E-mail addressed to the addresses on the left will go into
the ISP mailbox for the E-mail account on the right.  Mail Server
will then take all of the E-mail from the ISP and then sort it into
Andrew’s, Greg’s and Carolyn’s  mailboxes.  Those users can then
take their E-mail from the mailboxes in Mail Server onto their own
computer.  An address like mail@company.com is a standard E-mail
address format and all E-mail applications will recognize and send
this part of an address.  The names that are in the front of the E-mail
address (In our example, Andrew, Greg and Carolyn) are not
standard E-mail address format but most E-mail applications will still
include it and the mail will be delivered to the right mailbox.  If
someone sends a mail addressed to one of your clients and the E-mail
application they used to send it does not support this non-standard
extra name in front of the E-mail address, the mail will go into the
Admin1 account in Mail Server.

 You should let people know that in your E-mail address there
is a space here

                         name <mail@company.com>

 Most E-mail applications will not give any problems but some
programs, like Outlook Express and  Microsoft Exchange,  will not
be able to send if the space is not put in.

mail@company.com

andrew <mail@company.com>

greg <mail@company.com>

carolyn <mail@company.com>
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Installing Mail Server

        Before installing Mail Server you should make sure that the
computer that you are installing Mail Server on has a permanent
IP address on your LAN.  You can do this manually in the
computer that you will install Mail Server on or use a DHCP
server to give this computer a reserved IP address.   If you set
the IP address manually, you should also make sure that you set
the gateway to the device that will be connecting to  the Internet.

1. Insert the CD labeled  Mail Server Lite  into
a CD Rom Drive on a Windows 95/NT computer
that is on the same network as the device bundled with Mail
Server Lite.

2. On the Windows Start menu click Run.

3. Type “D:\mail server lite\setup.exe” where “D” is the
location of your CD Rom drive and press OK .

4. Follow the setup screen to complete the installation

The Setup Program will then bring you
into Setup Wizard…..

Note!
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Setup Wizard

Setup Wizard was designed to let you configure Mail
Server quickly and easily.   Setup Wizard is like a
shortcut that lets you  input all the basic settings that
are needed to configure Mail Server.  All settings

that are entered here will also be shown in their respective menus in
Mail Server Manager.
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1 Please Input Your E-mail Account Information

1) Enter your E-mail Address given to you by your ISP.

2) Usually the Account Name of an E-mail address is the portion
of the E-mail address to the left of the “@” symbol.   Setup
Wizard will automatically key this in for you.  If  your account
name is different from the one Setup Wizard has specified,
please change it.

3) Enter the Password for this E-mail account

4) Re-enter the password in the Password Verification field

5) Usually the SMTP Server Address and POP3 Server Address
are the same as the portion of the E-mail address to the right of
the “@” symbol.   Setup Wizard will automatically key this in
for you.  If  your SMTP Server Address or POP3 Server
Address is different from the ones Setup Wizard has specified,
please change them.
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2 Please Input who this E-mail account
will be  shared by

First choose whether this account is a Regular E-mail
Account or a Domain POP Account

To add a New Client:

1) Enter the User Name

The User Name will be the name that is used for this client
to login to Mail Server.   This will also be the name displayed at
the front of his/her E-mail address.

If you are sharing a regular ISP E-mail account,
you will see two usable E-mail addresses that this
client can use in the “Your Mail Address is”  field.  When
people want to send you mail they can use either of these two
addresses.

2) Enter this client’s Password

The Password will be the password needed for this client to
login to Mail Server for Mail services.

Note!
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3) Re-enter the password in  the Password Verification field

4) Choose Carbon Copy recipients from CC to:   

With the CC (Carbon Copy) function, you can select
members who share this ISP E-mail account to always receive a
copy of the mail that goes to this local user.

5)   Press Insert

Press Insert to add this person to the list of clients who will
share this ISP E-mail address.

ADMIN1  and PUBLIC1  are two E-mail addresses on Mail
Server that cannot be deleted.

1) ADMIN1  is the administrator’s address. All E-mail that
comes into the ISP E-mail account that does not have a local
user will be placed in the ADMIN1 mailbox.  The ADMIN1
password is the password that will be used to gain access to
Mail Server. Once ADMIN1 is given a password, that
password will be needed every time you wish to gain access
to Mail Server Manager.

2) PUBLIC1  is an address that can be used to E-mail every
local user sharing this ISP E-mail account.   For example if
someone sends an E-mail to public <mail@company.com>
everybody sharing the ISP E-mail account
mail@company.com will receive a copy of that E-mail.

   If you choose to enter a password for ADMIN1 pick
something that is easy to remember or write it down in a safe
location.  If you have completely forgotten your password please
contact your place of purchase

Note!

Warning!
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To Modify a Client:

1) First Select the client from the Client List

2) Change the settings that you want to modify

3) Press the Modify button

To Delete a Client:

1) First Select the client from the client list

2) Press the Delete button

……Press Next to Continue
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3
Please Select Your Options for

 Sending/Receiving Mail

Mail Server can check for new mail and send outgoing mail:

1)    Every _____ minutes.

This option lets you check for new mail and send outgoing
mail after a certain time period specified in minutes.

2)    When the number of messages to send reaches ______ .

       This option lets you check for new mail and send outgoing
mail when the number of messages in Mail Server’s Outbox
reaches a certain number.

Mail server will start to send/received mail for whichever
event comes first.

……Press Next to Continue

Note!
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4
Please re-check the settings that you have inputted

Please re-check the settings that you have inputted.  If you find
that there is anything incorrect or you would like to change a setting
you can press the Back button to see previous menus and change the
settings.

……Press Next to Continue
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You have now finished Setup Wizard! You can now start Mail
Server by clicking the Run Mail Server Manager  button.   To
learn how to setup different E-mail application programs please see
the Setting Up Your Clients section.
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Mail Server Manager

Running Mail Server Manager

To run Mail Server Manager from the Windows main Screen,
on the Windows 95/NT Start menu point to Programs, then to Mail
Server and select Mail Server Manager.  The Mail Server
Manager  will start and the main menu will open on your screen

If you have entered a password for the user ADMIN1  Mail
Server will prompt you to enter the password to get into Mail
Server.

Security on Mail Server Manager

Besides closing Mail Server Manager you can also let it run
idle by pressing the minimize button in the top right  hand corner of
the screen.  If you or anyone else then tries to re-open the Mail
Server  Manager Screen, it will ask you for the ADMIN1 password.

Note!
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Function Buttons
Start/Stop Used to Start and Stop Mail Server
User Setup Allows you to enter new users to share the ISP

E-mail accounts and also to add new E-mail
accounts that you want shared.

Timer Options Allows you to choose when Mail Server will
connect to your ISP to send and  receive mail.

View Log Allows you to see when E-mail was sent out
and retrieved from your ISP

Mailboxes Allows you to view the number of E-mails in
each user’s mailbox

Send/Receive Used to immediately connect to your ISP to
send and  receive mail

Indicators
Local Sending Indicates when E-mail is being sent from a

network client to Mail Server
Local Receiving Indicates when E-mail is being received by a

client  from Mail Server
Outgoing Indicates when E-mail is being sent from Mail

Server out to your ISP
Incoming Indicates when E-mail is being retrieved from

your ISP to Mail Server
Inbox Indicates the number of E-mails on Mail

Server that need to be retrieved by your
clients

Outbox Indicates the number of E-mails on Mail
Server that need to be sent out to your ISP.
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Option A

Option C

Option B

User Setup

User Setup lets you enter new users into your account and also
add new E-mail accounts that you want shared.

Select E-mail Account
         The E-mail Account window displays the account that

you want to configure.  You can select the E-mail account you wish
to configure from the E-mail Accounts menu.

Add E-mail Account
If you would like to add a new E-mail account to be

              shared click the Add E-mail Account button.

          Mail Server Lite  does not support this function.   Mail Server
Pro is also available and allows you to share 20 E-mail accounts with
each E-mail account supporting up to 64 users.  To obtain Mail
Server Pro please contact your Mail Server Lite  place of purchase.

       Delete E-mail Account
            If you would like to delete an E-mail account, first

select the E-mail account to be deleted and click the Delete E-mail
Account button.

Note!
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E-mail Account Information

1) Select whether this is a regular E-mail account or POP domain
account.

2) Enter your E-mail Address given to you by your ISP.

3) Usually the Account Name of an E-mail addreess is the portion
of the E-mail address to the left of the “@” symbol.   Mail
Server Manager  will automatically key this in for you.  If  your
account name is different from the one Mail Server Manager
has specified please change it.

4) Enter the Password for this E-mail account

5) Re-enter the password in the Password Verification field

6) Usually the SMTP Server Address and POP3 Server Address
are the same as the portion of the E-mail adress to the right of the
“@” symbol. Mail Server Manager will automatically key this
in for you.  If  your SMTP Server Address or POP3 Server
Address is different from the ones  Mail Server Manager has
speicified please change them.
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To add a New Client:

1) Enter the User Name

The User Name will be the name that is used for this client
to login to Mail Server for mail services and also the name
displayed at the front of the E-mail address.

If you are sharing a regular ISP E-mail account
You will see the two usable E-mail addresses that this
client can use in the “Your Mail Address is”  field.  When
people want to send you mail they can use either of these two
addresses.

2) Enter this client’s Password

The Password will be the password needed for this client to
login to Mail Server for Mail services.

3) Enter the Password Verification

Re-enter the password for this user

4) Choose Carbon Copy recipients from the CC to:   

Using the CC (Carbon Copy) function, you can select
members who share this account to always receive a copy of the
mail that goes to this user.

5)   Press Insert

Press Insert to add this person to the list of clients who will
share this E-mail address.

Note!
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To Modify a Client:

1) First Select the client from the Client List

2) Change the settings that you would like to modify

3) Press the Modify button

To Delete a Client:

1) First Select the client from the client list

2) Press the Delete button
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Timer Options

Timer options allows you to set when Mail
Server sends and receives mail..

1)   Send mail when the number of messages to send reaches __

The default setting of Mail Server will automatically connect
to your ISP to Send/Receive whenever an E-mail is send to
Mail Server’s Outbox.  You can change the specific number of
E-mails needed in Mail Server’s Outbox before it will connect
to your ISP to Send/Receive.   If you wish to you can also turn
off this option and let Mail Server Send/Receive at specific time
intervals.

2)    Schedule to Receive Mail.

Here you can set what days of the week, during what
specific times of the day and how often you want Mail Server
to check your ISP E-mail Account for mail.  The default setting
is set for Mail Server to check for Mail every 5 minutes, 24
hours a day, 7 days a week.   Please note that the clock setting is
a 24 hour clock.
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Log

The Log lets you see when E-mails were sent out and when E-
mail was collected from Mail Server.

You can select which day’s log you would like to see by
using the pull down menus for Year, Month  and Date.

The Keep Log for _____ Days, lets you specify the amount
of days that you would like to keep each day’s log for.  If for example
you specify 5 days.  The day’s log for 6 days ago will be
automatically deleted each time you run Mail Server.
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Mailboxes

Mailboxes allows you to view the number of E-mails on
Mail Server in each user’s mailbox.
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Setting Up Your Clients

The configuration that is needed to setup your E-mail
applications will depend on whether you are sharing a regular ISP
E-mail account or Domain POP account.

         Domain POP and Regular? What's the difference?
Please see the explanation at the beginning of this manual

The five major things that you should inform your clients when
sharing a regular ISP E-mail account are listed in the table below.

E-mail Address Enter the ISP E-mail address  being shared when
setting up your E-mail applications.   For example
you should enter mail@company.com AND NOT
andrew <mail@company.com>

User Name The user name is the left hand portion of the E-
mail address. For example in the E-mail address
andrew <mail@company.com> the user name is
“andrew”

Password The password of each client is the Password that
you gave them in Mail Server Setup Wizard or
Mail Server Manager.

SMTP Server You should enter the IP address of the computer
that Mail Server is installed on for this field

POP3 Server You should enter the IP address of the computer
that Mail Server is installed on for this field

You should also inform your clients that they need to set their E-mail
programs to  connect via a LAN connection.  Most E-mail programs
have this setting and there are some examples on the following pages

Sharing a Regular ISP E-mail Account

What?
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If you are sharing a Domain POP E-mail account, setting up a
Mail server Client is almost exactly the same as if it was a regular
E-mail address from your ISP.  The five major things that you should
let the Mail server clients know are listed below.

E-mail Address Clients just need to enter their E-mail
address as if it was a regular ISP E-mail
account.  For example if you are sharing
mail@company.com and it is being shared
by lisa@company.com you should enter
lisa@company.com

User name The user name is the portion to the left of
the "@" symbol.  For example the user
name for the E-mail address
greg@company.com is Greg

Password The password of each client is the
Password that you gave them in Mail
Server Setup Wizard or Mail Server
Manager.

SMTP Server You should enter the IP address of the
computer that Mail Server is installed on
for this field

POP3 Server You should enter the IP address of the
computer that Mail Server is installed on
for this field

You should also inform your clients that they need to set their E-mail
programs to  connect via a LAN connection.  Most E-mail programs
have this setting and there are some examples on the following pages

Sharing a Domain POP E-mail Account
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Where can I find a computer’s IP address?

To find out what the IP address of the computer  that Mail
server is installed on, you can use WINIPCFG or IPCONFIG.

 1)  WINIPCFG is for Windows 95:  On the Windows 95 Start
       button, select Run and type winipcfg

       In the above example this computer has an IP address of
       213 . 0 . 0 . 200 and the Default Gateway is 213 . 0 . 0 . 2.
       The default gateway should be the IAS IP address.

 2)  IPCONFIG is for Windows NT:  In the DOS command type
      IPCONFIG.

Unfortunately space has not permitted us to give example
configurations of every existing E-mail application program but
even  if your application is not one of our examples you can still
use our examples as a guide.

Note!
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1) Start Microsoft Outlook 98

2) On the Tools menu, select Accounts.  Click the Add button and
choose Mail .

3) The Internet Connection Wizard Screen will pop up asking
you to enter the name to Display.  If sharing a domain POP
E-mail account this can be any name you wish.  If sharing a
regular ISP account, this is the value that Mail Server will use to
sort the users sharing the ISP E-mail account, so you should
enter the local user name that you entered in  Setup Wizard or
Mail Server Manager.

Setting up Microsoft Outlook 98
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4) Internet E-mail Address

 If sharing a domain POP E-mail account enter your E-mail
address as if it was a real E-mail address.  If sharing a
regular ISP E-mail account,  enter only the ISP E-mail
address that this user is sharing in the E-mail Address
field. ie: mail@company.com

5) E-Mail Server Names

For the POP3 and SMTP server addresses, enter the IP
address of the computer that you installed  Mail Server on.
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6) Internet Mail Logon

Enter your account name and password.  These are the local
user names and passwords that you entered in Setup
Wizard or Mail Server Manager.

7) Friendly Name

Enter the name you want to give this new E-mail address
from Mail Server. This is only for your own personal
reference.
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8) Connection Type

Choose “Connect Using my local area network (LAN)”

9)  Press Finish to complete the E-mail setup
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1) Start Netscape Communicator

2) On the Edit  menu, select Preferences.  Open the Mail &
Groups menu.  Select Identity .

a) Your Name:  If you are sharing a domain POP E-mail
account you can enter any name you wish.  If you are
sharing a regular E-mail account you should enter the
local user name that you entered in  Setup Wizard or
Mail Server Manager.

b) E-mail address:  If sharing a domain POP E-mail
account enter your E-mail address as if it was a real E-
mail address.  If sharing a regular ISP E-mail account,
enter only the ISP E-mail address that this user is
sharing in the E-mail Address  field. ie:
mail@company.com

Setting up Netscape Communicator
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3) In that same Mail & Groups  menu, select Mail Server and
input the IP address of the computer that you installed Mail
Server in both the incoming Mail Server and outgoing Mail
Server fields. In the Mail Server User Name field enter the
local user name that you entered in Setup Wizard or Mail
Server Manager.

4) Make sure that Netscape is set to connect to Mail Server
through you LAN, if in the File menu  you see the option Go Off
line, you are already set to connect through your LAN.  If you
see the option Go Online, you should select this option, choose
what you want to do and then click the Go Online button.
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The Eudora setup is a little different then the other E-mail
application programs due to it’s configuration screens.

1) Start Eudora

2) On the Tools menu, select Options.  In the Personal  Info
section,  enter your local user name with the @ symbol followed
by the IP address of Mail server.  In our example the local
user’s name is Andrew and the computer's IP address that Mail
server is installed on is 213.0.0.117 so we have entered
andrew@213.0.0.117.  In the Real Name field enter the name of
this local user name that you entered in Setup Wizard or Mail
Server Manager.   In the return address field, if sharing a domain
POP E-mail account, enter your E-mail address as if it was a real
E-mail address and the ISP E-mail address. If sharing a regular
ISP E-mail account, enter the

Setting up Eudora
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3) Click the Hosts menu.  In the SMTP server field enter the IP
address of the computer that Mail Server is installed on.

4) Press OK to complete the E-mail setup
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Using Mail Server

You can think of Mail server exactly like you would think of
your ISP mail server.  Everything that you would want to do with an
ISP mail server you can do with Mail server.  For example, if you
would like to use remote mail with Mail server, you would setup
your E-mail program exactly the same as you would if Mail server
was like a regular ISP mail server

There is one important note that you should remember when
you are using Mail server.  You should let people know that in your
E-mail address there is a space here.

name <mail@company.com>

 Most E-mail programs will not give any problems but some
programs, like Outlook Express and  Microsoft Exchange,  will not
be able to send if the space is not put in.

Note!
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Troubleshooting

        I get this message on my screen when I try and run
Setup Wizard or Mail Server Manager

In order to run Mail Server Lite , the program needs to be
able to detect the hardware that it was originally purchased with.

� Make sure that the device that Mail Server Lite came
bundled with is properly connected to your network and
make sure that the computer that you have installed Mail
server on is properly connected to your network.  A good
method is to test both of these problems is to “Ping” the IP
address of the device that Mail Server Lite came bundled
with.  You can do this in the DOS prompt by typing,  for
example “Ping  213 . 0 . 0 . 117” where 213 . 0 . 0 . 117 is the
IP address of the device the Mail Server Lite  was bundled
with.   If the ping is unsuccessful, either your computer or the
device is not properly connected to your network.  Another
possibility is that your computer is not properly configured
for TCP/IP protocol.

Trouble #1
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           I can’t get connect to Mail Server to get my mail.

�           Make sure that Mail Server is running

� Make sure that this E-mail application is set to connect through
your LAN.

       My contacts  are always forgetting to put the name part
in front of my address  name <mail@company.com> so when the
mail comes in, it goes to the administrator’s account ADMIN1

� The name part in front of the E-mail address is what Mail
Server uses to sort the E-mail addresses that it receives.  If
people sending you E-mail are not putting that name in front of
the E-mail address,  Mail Server will not be able to sort the
Mail.  Most mail programs support an automatic signature that
you can put on your E-mails with your name, address and
anything else you want to include.  To help let people know
that the entire address name <mail@company.com>  is your
real E-mail address, you can advise them in the auto signature
file.

Trouble #2

Trouble #3
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Glossary

Domain POP Account:  A special type of E-mail account that some
ISPs support.  With this type of account all mail that goes to the mail
address anything@company.com where "anything" can be any text
string will go into the same mailbox.   Please see the explanation at
the beginning of this manual.

Electronic Mail (E-mail) :   A system whereby a computer user can
exchange messages with other computer users (or groups of users)
via a communications network

POP3 Server:  POP3 stands for Post Office Protocol Version 3  and
is a protocol designed to allow hosts to read mail from a server.
Messages you receive are stored in your E-mail account on an E-mail
Server  in your ISP that supports POP3.

Protocol.  A formal description of message formats and the rules two
computers must follow to exchange those messages.  By using the
same protocols, two computers can communicate with each other on
a network even if they are made by different vendors.

SMTP Server: SMTP stands for Simple Mail Transfer Protocol and
is a protocol used to transfer electronic mail between computers.
Messages you send are submitted to an E-mail Server that supports
SMTP protocol called an SMTP Server.

Server.  A provider of resources (e.g., file servers and name servers).
A computer that uses the resources of a server is called a Client.  For
example, Mail server provides E-mail Services.  The computers that
use the Mail server are clients of the Mail server and are thus called
Mail server Clients.


